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This chapter describes how to create transactions which are packaged as output data
records containing Job On and Job Off data and sent to a disk file.

Task 8:  Creating the JON_Tran (Job On) Transaction
When the user runs your application at the start of a job, data collected for the
Job On transaction includes a constant value (“JOTRAN”), the worker’s Badge
ID Number, the Part Number, the Order Number, the date and the time.

To create the JON_Tran transaction

1. From the Object List, choose the JobOn screen, as illustrated next.

2. From the File menu, choose the New Transaction command. You will see
the Transaction Editor dialog box, as illustrated next.

3. Notice there are three main parts to the Transaction Editor dialog box.
• An area where you can enter a Constant Value.
• A list of the Source Fields you have created.
• An area where you can create a list of Transaction Fields.

4. Notice the two small buttons marked with the > symbol. One button moves
the Constant Value into the Transaction Fields list and the other moves
selected field(s) from the Source Fields list into the Transaction Fields list.

5. Notice the small button marked with the >> symbol. This moves ALL fields
in the Source Fields list into the Transaction Fields list.
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6. The two small buttons marked < and << remove (selected or ALL) fields
from the Transaction Fields list.

Note: As a general rule, you may want to avoid using the >> button because it
moves ALL the data fields over, and you may not need them all. Also, the fields will
be in the same (alphabetic) order as they are in the Source Fields list. You may not
want the fields in this order in the Transaction record.

7. The transaction default name, “Tran0,” is shown in the Object List. Enter
“JON_Tran” in the Name property to rename this transaction, as illustrated
next.
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8. In the Transaction Editor dialog box, enter “JOTRAN” as the Constant

Value. Click the Constant Value’s small button marked with > to move the
value you entered into the Transaction Fields list, as illustrated next.

Note: The value, JOTRAN, as the first output data item in a transaction record,
identifies the data record as a Job On type of transaction.

9. In the list of Source Fields, highlight the JobOn.BadgeNo, JobOn.OrderNo,
and JobOn.PartNum fields, as illustrated next. (Hold down the Ctrl key or
Shift key on your keyboard while you select multiple fields.)
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10. Click the Source Fields button marked with > to move the highlighted
fields into the list of Transaction Fields.

Note: Another method is to grab the highlighted Source Fields with the mouse and
drag them into the Transaction Fields list. Alternatively, you can just double-click
on the items in the Source Fields list.

11. Notice that, for this tutorial exercise, the data fields shown in the previous
illustration are in the wrong order in the Transaction Fields list.

Note: The JobOn and JobOff screens were designed to show the data fields ordered
(top to bottom) as Badge ID, Part Number, and then Order Number. This is also
shown in the Job On Transaction Process illustration shown in Chapter 1. This
order is also shown in the Example Output part of Chapter 5.

12. The data fields in the Transaction Fields list should be in the same order as
they are shown on the JobOn and JobOff screens, not in alphabetic order.
To correct this, click to highlight JobOn.PartNum in the Transaction Fields
list, as illustrated next.

13. Use your mouse to drag the highlighted JobOn.PartNum field to its correct
place, up above the JobOn.OrderNo field, as illustrated next.
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14. Highlight the automatic <DATE> and <TIME> in the Source Fields list and
drag or click the > button to move them over to the Transaction Fields list.

Note: You now have six items in the Transaction Fields list: JOTRAN, three data
input fields (JobOn.BadgeNo, JobOn.PartNum, and JobOn.OrderNo) and the
automatic Date and Time from the system. You will not change the current
property settings (which may be default properties or your own previously set
properties) for most of these fields. However, for Date, you will replace the default
comma delimiter with a blank character, and you will omit a trailing comma after
the Time data.

To adjust Date properties for the JON_Tran transaction

1. Highlight <DATE> in the Transaction Fields list. Notice the properties that
are not grayed and may be set at this time. Notice Override = False.

Note: Override = False means that you do not want to override current property
settings. Override = True means that you do want to override the current property
settings. These current settings are defaults set at transaction level for all the fields
in this transaction except the length of the transaction field which is inherited from
the input field.

2. Double-click to set Override = True, as illustrated next. When you click to
end that entry, notice that Delineation, Delimiter, Length, and Formatting
properties may now be set or changed.
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3. The Delineation remains = Delimiter. (This means you will use a delimiter
character following the Date field—to separate it from the Time field in the
output record.) The default Delimiter property is a comma; you will change
that Delimiter property.

4. Set the Delimiter to one space character. To do this, highlight the default
comma and press the space bar on your keyboard once.

5. Length automatically changes to the default of 10. (The date’s length can be
changed, as needed for the Formatting you choose in the next step.)

6. Click Formatting to get its drop-down list, as illustrated next, and choose
the MM-DD-YYYY format option (this date format is ten characters).
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7. Check the Date properties result with the next illustration.

To adjust Time properties for the JON_Tran transaction

1. Highlight <TIME> in the Transaction Fields list.

2. Double-click to set Override = True. This lets you override the default
Delineation (Delimiter = comma).

Note: EZBuilder does not attach a trailing (Delimiter) comma after the last field in
any transaction. However, we want to change the Delineation from Delimiter to
Length. To change Delineation, we need to first set Override = True.

3. Double-click to set Delineation = Length. As soon as you end that entry,
notice the Delimiter property (the comma) is automatically deleted and
Delimiter becomes grayed.

Note: Time is the last field specified for the output record (see Transactions Fields
list). The Delineation property of Length means the automatic carriage return that
ends the record will occur immediately after the final character of the Time field is
automatically filled, considering the Length and Formatting properties.

4. Length automatically changes to the default of 8. (The time’s length can be
changed, as needed for the Formatting you choose in the next step.)

5. From the Formatting property drop-down list, choose the HH:MM:SS
format option (this time format is eight characters).

6. Check the Time properties result with the next illustration.
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To adjust Transfer Direction for the JON_Tran transaction

Note: There is one more thing to do before you are finished with the JON_Tran
transaction. The default Transfer Direction sends your transactions to the network. For
this tutorial exercise, you need to tell EZBuilder that you want to send the transactions
to a file.

1. Click the small ^ button to get the JON_Tran (parent screen) again, as
illustrated next.
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2. Click the Transfer Direction property and then its small button with the

three dots to get the Transaction Direction Editor dialog box, as illustrated
next. Notice the default Destination option is Port and the port to which a
JON_Tran transaction is sent is Network.

3. Click to change the Destination from the Port option to the File option.
Enter the filename to which you want to send the transactions (the Job On
and Job Off data). An example filename, JOFILE, is illustrated next.

Note: Make up a unique filename, perhaps “JOSMITH” for example.
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4. Click OK. Suppose, as shown in the previous illustration, you forgot that
you must enter a drive letter first, and you enter only a filename (for
example, JOFILE). The following message will be presented to remind you
to enter the drive letter first.

5. Click OK to close the reminder message. Enter the correct drive letter and
filename for your output data file. For example, enter “C:JOFILE,” as
illustrated next.

Note: The drive letter:filename format is the only valid format for the TRAKKER
Antares.

Note: The file named here will be located in the Output path that you specify in the
Build Options dialog box in Chapter 5. The C drive is a Flash drive; the E drive is
used if you plan to download to a RAM drive; the G drive is used as an extended
storage drive. For file management and RAM drive details, see the EZBuilder
Getting Started Guide.
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6. Click OK. The result of the previous Transfer Direction Editor steps is
shown in the next illustration.

Note: You can remove items from the filenames list. If you need to remove an error
filename, from the View menu, choose the Resource command. At the bottom of the
View Resource dialog box, use the right arrow to get to the File Names page. Delete
the unwanted filename from the File Names page.

7. You have completed Task 8. Save your file. Continue with Task 9.
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Task 9:  Creating the JOF_Tran (Job Off) Transaction
When the user runs your application at the end of a job, data collected for the
Job Off transaction includes a constant value (“JOFTRAN”), the worker’s Badge
ID Number, the Part Number, the Order Number, the date and the time.

To create the JOF_Tran transaction

1. From the File menu, choose the New Transaction command.

2. Click to highlight “Tran0” (the default name) in the Name property, as
illustrated next.

3. Rename the transaction to “JOF_Tran” in the Name property, as illustrated
next.
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Note: The next several steps are brief because they are similar to those you did for
the JOTRAN transaction. Refer back to Task 8 for details or illustrations.

4. In the Transaction Editor dialog box, enter “JOFTRAN” as the Constant
Value. Click the Constant Value’s small button marked with > to move the
“JOFTRAN” value into the Transaction Fields list. As the first field in the
data record, “JOFTRAN” will identify the record as a Job Off transaction.

5. In Source Fields list, highlight the JobOff.BadgeNo, JobOff.OrderNo, and
JobOff.PartNum fields to be the next three fields in the record. (Hold down
the Ctrl key or Shift key on your keyboard to highlight multiple fields.)

6. Drag the fields, or click the Source Fields > button, to move the highlighted
fields into the Transaction Fields list.

7. In the Transaction Fields list, highlight the JobOff.PartNum field and use
your mouse to drag it above the JobOff.OrderNo field. Release mouse.

8. In the Source Fields list, double-click <DATE> and then double-click
<TIME> to quickly move these fields over to the Transaction Fields list.

9. Check to be sure you have six fields in the Transaction Fields list, as
illustrated next.
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10. Like for the JON_Tran transaction that you completed earlier, the current
properties remain as they are for all the Transaction Fields except the
<DATE> and <TIME> fields. These two fields will be changed the same
way as you changed them for the JON_Tran transaction.

To adjust Date properties for the JOF_Tran transaction

1. Highlight <DATE> in the Transaction Fields list to set the Date properties.

2. Double-click to set Override = True.

3. Change the Delimiter property from a comma to one blank character.

4. Choose the MM-DD-YYYY Formatting option.

5. Check the Date properties result with the next illustration.
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To adjust Time properties for the JOF_Tran transaction

1. Highlight <TIME> in the Transaction Fields list.

2. Double-click to set Override = True.

3. Double-click to set Delineation = Length.

4. Choose the HH:MM:SS Formatting option (eight characters).

5. Check the Time properties result with the next illustration.
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To adjust Transfer Direction for the JOF_Tran transaction

1. Click the small ^ button to make the JOF_Tran (parent screen) active again,
as illustrated next. Notice the Transfer Direction property.

2. Click in the Transfer Direction property and click its small button to bring
up the Transaction Direction Editor.

3. In this tutorial exercise, both JON_Tran and JOF_Tran transactions go into
the same output file. Change the Destination from the Port option (showing
“Network”) to the File option, and name the same drive and file that you
named for the JON_Tran transaction in Task 8, as shown in the next
illustration. Click OK to close the Transaction Direction Editor dialog box.
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Note: Later, when the program is run, there should be one JOTRAN (Job On)
transaction for a specific job, followed by that job’s JOFTRAN (Job Off)
transaction. These will be followed by other pairs of JOTRAN and JOFTRAN
transaction records as further jobs are finished. (See Chapter 5 for example output.)

4. You have completed Task 9. Save your file, and continue with Task 10.

Task 10:  Finishing the Transactions
Before you can build and test your program, there is a little bit more work to
do for both the Job On Screen and Job Off Screen that relates to the JON_Tran
and JOF_Tran transactions that you just created.

As your program stands right now, the user will enter or scan the Badge ID
Number, the Part Number, and the Order Number, in that order. The program
still needs to be told that upon exiting the scan (or entering the last keystroke)
of the Order Number (the last data field), all the gathered information must be
packaged by the transaction and sent to the file.

To finish the Job On Transaction

1. From the Object List, choose the Job On screen, as illustrated next.

2. In the Viewport, double-click the shaded data field labeled “Order.”  You
should have the same result as illustrated next.
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3. Notice the tabs at the bottom of the Object Manager window. The
Properties tab is currently shaded (highlighted), as illustrated above. Click
the On Exit tab, and the Validation dialog box will be presented to you.

4. In the Validation dialog box, click the (blank) Do Transaction property, then
click the property’s down arrow to see the two options, JOF_Tran and
JON_Tran, as illustrated next.



Creating Transactions

4-21

4
5. Choose the JON_Tran option for the Do Transaction property, as illustrated

next. This tells EZBuilder that, when the user exits the Order data field, you
want the program to generate a Job On transaction.

Note: In other words, when the user of your program finishes the scan or entering
of the Order data, an output record is sent to the file. The record will start with the
JOTRAN identifier to indicate it is a Job On Transaction. The record will also
contain the Badge, Part, and Order data as well as Date and Time of transaction.
(See Chapter 1 for an illustration of this process; see Chapter 5 for example data.)

To finish the Job Off Transaction

Note: These steps are similar to what you just did for the Job On screen. Refer back to
the previous steps if you want illustrations of each step.

1. From the Object list, choose the Job Off screen.

2. In the Viewport, double-click the shaded data field labeled “Order.”

3. At the bottom of the Object Manager window, click the On Exit tab to get
the Validation dialog box.

4. In the Validation dialog box, click the (blank) Do Transaction property, then
click the property’s down arrow to see the two options, JOF_Tran and
JON_Tran.

5. Choose the JOF_Tran option for the Do Transaction property, as illustrated
next. This tells EZBuilder that, when the user exits the Order data field, you
want the program to generate a Job Off transaction.
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Note:  In other words, when the user of your program finishes the scan or entering
of the Order data, an output record is sent to the file. This record will start with the
JOFTRAN identifier to indicate it is a Job Off Transaction. The record will also
contain the Badge, Part, and Order data as well as Date and Time of transaction.
(See Chapter 1 for an illustration of this process; see Chapter 5 for example data.)

6. You have completed Task 10. Save your file. Continue with Task 11.

Task 11:  Creating the CopyBadge Transaction

Note: This Task is optional, but it presents a good way you can save some user time
when running this type of application. We recommend you complete this task.

To review the tutorial application: Upon starting a new job, the user scans a bar
code or enters the letters “SFCLBR” (Start Factory Labor). This input data tells
the terminal that a JobOn transaction is started and automatically sends the
JOTRAN constant value into the JON_Tran Transaction Fields list.

The user then enters or scans the other Job On transaction data—the Badge ID
Number, Part Number, and Order Number—in that order.

Following that, the job activity is performed by the user.

Upon ending the job, the user scans a bar code or enters the letters “EFCLBR”
(End Factory Labor). This input data tells the terminal that a JobOff transaction
is started and automatically sends the JOFTRAN constant value into the
JOF_Tran Transaction Fields list. The user again enters or scans the (same)
Badge ID Number, Part Number, and Order Number data, in that order.
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Notice that for this tutorial exercise, with the exception of the SFCLBR and
EFCLBR codes, the same three data fields are entered and scanned twice—at
the start of a job and at the end of a job.

Suppose the same three data fields were automatically entered at the end of the
job? The user saves time, having to only enter or scan the EFCLBR at the end of
the job to generate the Job Off transaction. Not only does it save time, but it
ensures accuracy as well—especially if data is keyed in by the worker.

This task will show you how to accomplish the automatic copying of data from
one field (JobOn.BadgeNo) into another field (JobOff.BadgeNo). To save
tutorial time, we will show you how to create only the CopyBadge transaction.
You can apply the same methodology to create CopyPart and CopyOrder
transactions, if you want.

To create the CopyBadge Transaction

1. From the Object List, choose the JobOn screen.

2. In the Viewport, double-click on the shaded BadgeNo data area to select it
(get its handles) and to see its properties, as illustrated next.

3. At the bottom of the Object Manager window, click the On Exit tab.

4. On the Validation page, type “CopyBadge” in the Do Transaction property,
as illustrated next. Do not end the entry yet; leave your cursor in the Do
Transaction property field (see next step).
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5. Without first ending the entry, double-click on the “CopyBadge” text you
just typed as the Do Transaction property. The CopyBadge transaction will
be created (and shown in the Object List), and you will see the CopyBadge
transaction properties in the Object Manager and the Transaction Editor
dialog box, as illustrated next.

Note: The constant value, JOFTRAN, will show in the Constant Value area (as
previously illustrated) if you have continued your tutorial exercise without exiting
at any time since entering that value. The Constant Value, like some other values,
is a temporary value that is not saved when you exit EZBuilder. Therefore, some of
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your screens may look slightly different because you will not see the temporary
values on your screen unless you work straight through the exercise—as was done
to capture the screen pictures for this document. Also, do not let the Constant
Value “JOFTRAN” confuse you. The Constant Value is not part of the transaction
you are now defining; only those objects you move into the Transaction Fields list
become part of the current transaction you are defining.

6. In the Source Fields list, double-click JobOn.BadgeNo to move it to the
Transaction Fields list.

7. Click the Transfer Direction property which has the default To Network, as
illustrated next. See its small button with the three dots.

8. Click the Transfer Direction property’s small button with the dots to get the
Transaction Direction Editor dialog box. This is where you tell EZBuilder
where you want to automatically send the JobOn.BadgeNo data.

9. In the Transaction Direction Editor dialog box, choose the Destination
option “Field.” From the drop-down list for that option, choose the
JobOff.BadgeNo field, as illustrated next.
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10. Click OK to close the Transaction Direction Editor dialog box. Check your
Transfer Direction property result with the next illustration.

11. Highlight the Delimiter property (the comma) and delete it, as illustrated
next.
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Note: With the above method, when the user selects the Job On transaction from
the Main Menu and enters the Badge ID Number into the JobOn.BadgeNo field,
that data is automatically entered into the Job Off transaction’s JobOff.BadgeNo
field as well. If desired, you could also code Part Number and Order Number data
to also automatically move from the JobOn data fields to their corresponding JobOff
data fields.

There is one important thing to clean up. The copying occurs when the user enters
data on the JobOn screen. However, when the user goes to the JobOff screen, the
default is to clear all fields from a previous JobOff transaction (as typically desired).
You must now go back to the Job Off screen and tell EZBuilder to stop that
automatic clearing of the JobOff.BadgeNo data because you want it saved. The next
few steps take care of that process for Badge ID Number data. However, if you have
also coded Part Number and Order Number to be automatically entered into the
JobOff transaction, you will want to do these next few steps for those fields as well.

12. From the Object List, go to the JobOff screen, as illustrated next.
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13. In the Viewport, double-click to select the Badge data field, as illustrated
next.

14. In the Object Manager, scroll down to near the bottom and locate the Clear
on Screen Entry property. See the default is True, as illustrated below.
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15. Double-click to change the Clear on Screen Entry property from True to
False, as illustrated below.

Note: Repeat Steps 13 through 15 for Part and Order data fields if you had coded
EZBuilder to automatically move their JobOn transaction data into the JobOff
transaction fields.

16. You have finished Task 11. Save your file. Continue with Task 12.
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Task 12:  Creating “Toggle Screen” Capability

Note: This is an optional task for this tutorial.

The way the application is currently coded, the user views your Main Menu
and presses F2 to go to the JobOn screen where data is captured at the start of a
job. Then, the user presses Esc to return to the Main Menu where F3 can be
pressed to take the user to the JobOff screen so data can be captured at the end
of the job.

To make it more convenient for the user, this optional task will code your
application so the user can go straight to the JobOff screen from the JobOn
screen (without having to first return to the Main Menu), and also the user can
go back to the JobOn screen straight from the JobOff screen. This is called
“toggling between” or “chaining of” screens.

To create toggle capability from JobOff to JobOn screen

1. From the Object List, go to the JobOff screen.

2. In the Viewport, double-click to select the Order data field, as illustrated
next.

3. At the bottom of the Properties and Actions area, choose the On Exit tab,
then choose the On Val Succeed tab.

4. Click to highlight the Navigation Choice property, as illustrated next.
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5. Click the Navigation Choice property’s small button with the three dots to
bring up the Navigation Selection dialog box.

6. In the Navigation Selection dialog box, select the Go to Field option and
choose the JobOn.BadgeNo field from the drop-down list, as illustrated
next.

7. Click OK to close the Navigation Selection dialog box.



EZBuilder Tutorial

4-32

To create toggle capability from JobOn to JobOff screen

1. From the Object List, go to the JobOn screen.

2. In the Viewport, double-click to select the Order data field.

3. At the bottom of the Properties and Actions area, choose the On Exit tab,
then choose the On Val Succeed tab.

4. Click to highlight the Navigation Choice property.

5. Click the Navigation Choice property’s small button with the three dots to
bring up the Navigation Selection dialog box.

6. In the Navigation Selection dialog box, select the Go to Field option and
choose the JobOff.BadgeNo field from the drop-down list, as illustrated
next.

7. Click OK to close the Navigation Selection dialog box.

8. You have completed Task 12. Save your file.
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Chapter Summary

This chapter gave you exercises in creating transactions. It included the
creation of Job On, Job Off, and CopyBadge transactions. You also learned how
to format the system date and time for automatic date and time stamps, and
you learned how to transfer the collected data to a disk file. You also learned
how to transfer input data entered on one transaction (JobOn.BadgeNo) into
another transaction’s field (JobOff.BadgeNo) to be saved for output.

In addition, if you chose to do the optional Task 12, you also learned how to
code the capability of toggling transactions; if so, be sure to test this capability
during your testing process in Chapter 5.

The EZBuilder components covered up to this point in the tutorial are shaded
in the next illustration. You now have finished everything you need to have
EZBuilder generate your application program

When you are ready to build and test your application program, continue with
Chapter 5. If you want, you can use the example data output provided in
Chapter 5. Also, Chapter 5 provides information regarding downloading your
application program to the terminal.

Tutorial Exercise Summary

Application: EZBTUTRL

           Menu    Screens          Transactions
            (Chapter 2)    (Chapter 3)               (Chapter 4)

 Tasks 1, 2 and 3

MainMenu

Task 4

MM_Help
Task 5

JobOn
Task 6

JobOff
Task 7

Data_Help

Task 8 and 10

JON_Tran

Task 9 and 10

JOF_Tran

Task 11

CopyBadge

EZB.005




